
Notices   i 

Notices

No part of this publication may be reproduced, stored in a retrieval system, or 
transmitted, in any form or by any means, mechanical photocopying, recording or 
otherwise, without the prior written permission of the manufacturer.

The information within this manual is subject to change without notice.

The manufacturer shall not be held liable for technical or editorial errors or omissions 
contained in herein; nor for incidental or consequential damages resulting from the

furnishing, performance or use of this material.

Microsoft Windows is a registered trademark of the Microsoft Corporation.

Product names mentioned herein are for identification purposes only, and may be 
trademarks and/or registered trademarks of their respective companies.

Macrovision Statement
If your computer has a DVD drive and an analog TV Out port, the following 
paragraph applies:

This product incorporates copyright protection technology that is protected by method 
claims of certain U.S. patents and other intellectual property rights owned by 
Macrovision Corporation and other rights owners. Use of this copyright protection 
technology must be authorized by Macrovision Corporation, and is intended for home 
and other limited viewing uses only unless otherwise authorized by Macrovision 
Corporation. Reverse engineering or disassembly is prohibited.

Copyright 2003 All rights are reserved
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Important Safety Information

Safety Instructions

Your system is designed and tested to meet the latest standards for safety of 
information technology equipment. However, to ensure safe use of this product, it is 
important that the safety instructions marked on the product and in the documentation 
are followed.

Always follow these instructions to help guard against personal injury and 
damage to your system.

i

Setting Up your System
Read and follow all instructions marked on the product and in the 
documentation before you operate your system. Retain all safety and operating 
instructions for future use.

Do not use this product near water or a heat source such as a radiator.

Set up the system on a stable work surface.

The product should be operated only with the type of power source indicated on 
the rating label.

Ensure that the electrical outlet you are using to power your equipment is easily 
accessible in case of fire or short circuit.

If your computer has a voltage selector switch, make sure that the switch is in 
the proper position for your area.

Openings in the computer case are provided for ventilation. Do not block or 
cover these openings. Make sure you provide adequate space, at least 6 inches 
(15 cm), around the system for ventilation when you set up your work area.
Never insert objects of any kind into the computer ventilation openings.

Ensure that the fan vents on the bottom of the casing are clear at all times. Do 
not place the computer on a soft surface, doing so will block the bottom vents.

If you use an extension cord with this system, make sure that the total ampere 
rating on the products plugged into the extension cord does not exceed the 
extension cord ampere rating.
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Care During Use
Do not walk on the power cord or allow anything to rest on it.
Do not spill anything on the system. The best way to avoid spills is to not eat or 
drink near your system.
Some products have a replaceable CMOS battery on the system board. There is 
a danger of explosion if the CMOS battery is replaced incorrectly. Replace the 
battery with the same or equivalent type recommended by the manufacturer.
Dispose of batteries according to the manufacturer’s instructions. If the CMOS 
battery requires replacement insure that a qualified technician performs the task
When the computer is turned off, a small amount of electrical current still flows 
through the computer. To avoid electrical shock, always unplug all power 
cables, remove the battery and modem cables from the wall outlets before 
cleaning the system.
Unplug the system from the wall outlet and refer servicing to qualified 
personnel if:
– The power cord or plug is damaged.
– Liquid has been spilled into the system.
– The system does not operate properly when the operating instructions are 

followed.
– The system was dropped or the casing is damaged.
– The system performance changes.

The Instruction On Safety Operation of NotePC 
1. At installation and operation of devices it is necessary to carry out requirements of 

the user's guide. 

2. Devices can be used only with the equipment specified in the technical 
specifications of the devices. 

3. At operation of devices it is necessary to carry out the basic requirements 

4. At occurrence of malfunctions in the device (a smell of burnt isolation, a smoke, 
etc.), it is necessary to disconnect the equipment from the power supply and to not 
to inserted back before reparation. 

5. Service and reparation of devices should be carried out by experts of the 
manufacturer.

 Technical director of the service center 

Replacement Parts and Accessories
Use only replacement parts and accessories recommended by manufacturer.
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To reduce the risk of fire, use only No. 26 AWG or larger telecommunications 
line cord.

Written by: Daryl L. Osden

Do not use this product in areas classified as hazardous. Such areas include 
patient care areas of medical and dental facilities, oxygen rich environments, 
or industrial areas.

Battery Disposal

Do not put rechargeable batteries or products powered by non-removable 
rechargeable batteries in the garbage.

Contact the Samsung Helpline for information on how to dispose of batteries that you 
cannot use or recharge any longer.
Follow all local regulations when disposing of old batteries.

Laser Safety

All systems equipped with CD or DVD drives comply with the appropriate safety 
standards, including IEC 825. The laser devices in these components are classified as 
“Class 1 Laser Products” under a US Department of Health and Human Services 
(DHHS) Radiation Performance Standard. Should the unit ever need servicing, contact 
an authorized service location.

Laser Safety Note:
Use of controls or adjustments or performance of procedures other than those 
specified in this manual may result in hazardous radiation exposure. To 
prevent exposure to laser beams, do not try to open the enclosure of a CD or 
DVD drive.

Power Cord Requirements

The power cord set (wall plug, cable and AC adapter plug) you received with your 
computer meets the requirements for use in the country where you purchased your 
equipment.
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Power cord sets for use in other countries must meet the requirements of the country 
where you use the computer. For more information on power cord set requirements, 
contact your authorized dealer, reseller, or service provider.

General Requirements
The requirements listed below are applicable to all countries:

The length of the power cord set must be at least 6.00 feet (1.8m) and a 
maximum of 9.75 feet (3.0m).

All power cord sets must be approved by an acceptable accredited agency 
responsible for evaluation in the country where the power cord set will be used.

The power cord set must have a minimum current capacity of 7 A and a 
nominal voltage rating of 125 or 250 volts AC, as required by each country’s 
power system.

The appliance coupler must meet the mechanical configuration of an EN 60 
320/IEC 320 Standard Sheet C7 connector, for mating with appliance inlet on 
the computer.
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Regulatory Compliance Statements

Wireless Guidance

Low power, Radio LAN type devices (radio frequency (RF) wireless communication 
devices), operating in the 2.4 GHz Band, may be present (embedded) in your notebook 
system. The following section is a general overview of considerations while operating 
a wireless device.

Additional limitations, cautions, and concerns for specific countries are listed in the 
specific country sections (or country group sections). The wireless devices in your 
system are only qualified for use in the countries identified by the Radio Approval 
Marks on the system rating label. If the country you will be using the wireless device 
in, is not listed, please contact your local Radio Approval agency for requirements. 
Wireless devices are closely regulated and use may not be allowed.

The power output of the wireless device or devices that may be embedded in your 
notebook is well below the RF exposure limits as known at this time. Because the 
wireless devices (which may be embedded into your notebook) emit less energy than 
is allowed in radio frequency safety standards and recommendations, manufacturer 
believes these devices are safe for use. Regardless of the power levels, care should be 
taken to minimize human contact during normal operation.

As a general guideline, a separation of 20 cm (8 inches) between the wireless device 
and the body, for use of a wireless device near the body (this does not include 
extremities) is typical. This device should be used more than 20 cm (8 inches) from the 
body when wireless devices are on and transmitting.

This transmitter must not be collocated or operate in conjunction with any other 
antenna or transmitter.

Some circumstances require restrictions on wireless devices. Examples of common 
restrictions are listed below:

Radio frequency wireless communication can interfere with equipment on 
commercial aircraft. Current aviation regulations require wireless devices to be 
turned off while traveling in an airplane. 802.11B (also known as wireless 
Ethernet or Wifi) and Bluetooth communication devices are examples of 
devices that provide wireless communication.
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In environments where the risk of interference to other devices or services is 
harmful or perceived as harmful, the option to use a wireless device may be 
restricted or eliminated. Airports, Hospitals, and Oxygen or flammable gas 
laden atmospheres are limited examples where use of wireless devices may 
be restricted or eliminated. When in environments where you are uncertain of 
the sanction to use wireless devices, ask the applicable authority for 
authorization prior to use or turning on the wireless device.

Every country has different restrictions on the use of wireless devices. Since 
your system is equipped with a wireless device, when traveling between 
countries with your system, check with the local Radio Approval authorities 
prior to any move or trip for any restrictions on the use of a wireless device in 
the destination country.

If your system came equipped with an internal embedded wireless device, do 
not operate the wireless device unless all covers and shields are in place and 
the system is fully assembled.

Wireless devices are not user serviceable. Do not modify them in any way. 
Modification to a wireless device will void the authorization to use it. Please 
contact manufacturer for service.

Only use drivers approved for the country in which the device will be used. See 
the manufacturer System Restoration Kit, or contact manufacturer Technical 
Support for additional information.



viii  Users Manual

United States of America

USA and Canada Safety Requirements and Notices
Do not touch or move antenna while the unit is transmitting or receiving.

Do not hold any component containing the radio such that the antenna is very close or 
touching any exposed parts of the body, especially the face or eyes, while transmitting.

Do not operate the radio or attempt to transmit data unless the antenna is connected; if 
not, the radio may be damaged.

Use in specific environments:

The use of wireless devices in hazardous locations is limited by the constraints posed 
by the safety directors of such environments.

The use of wireless devices on airplanes is governed by the Federal Aviation 
Administration (FAA).

The use of wireless devices in hospitals is restricted to the limits set forth by each 
hospital.

Antenna use:

In order to comply with FCC RF exposure limits, low gain integrated antennas should 
be located at a minimum distance of 20 cm (8 inches) or more from the body of all 
persons.

High-gain, wall-mount, or mast-mount antennas are designed to be professionally 
installed and should be located at a minimum distance of 30 cm (12 inches) or more 
from the body of all persons. Please contact your professional installer, VAR, or 
antenna manufacturer for proper installation requirements.

Explosive Device Proximity Warning

Do not operate a portable transmitter (such as a wireless network device) near 
unshielded

blasting caps or in an explosive environment unless the device has been 
modified to be qualified for such use.

Antenna Warning

To comply with the FCC and ANSI C95.1 RF exposure limits, it is 
recommended for Intel® PRO/Wireless Network Connections installed in a 
desktop or portable computer, that the antenna for this device be installed 
so as to provide a separation distance of al least 20 cm (8 inches) from 
all persons and that the antenna must not be co-located or operating 
in conjunction with any other antenna or radio transmitter. It is 
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recommended that the user limit exposure time if the antenna is 
positioned closer than 20cm (8 inches).

Use On Aircraft Caution

Regulations of the FCC and FAA prohibit airborne operation of radio-
frequency wireless devices because their signals could interfere with critical 
aircraft instruments.

Other Wireless Devices

Safety Notices for Other Devices in the Wireless Network: Refer to the 
documentation supplied with wireless Ethernet adapters or other devices in the 
wireless network.

The Part 15 radio device operates on a non-interference basis with other 
devices operating at this frequency. Any changes or modification to said 
product not expressly approved by Intel could void the user's authority to 
operate this device.

Unintentional Emitter per FCC Part 15
This device complies with Part 15 of the FCC Rules. Operation is subject to the 
following two conditions:(1) this device may not cause harmful interference, and (2) 
this device must accept any interference received, including interference that may 
cause undesired operation.

Written by: Daryl L. Osden

This equipment has been tested and found to comply with the limits for a Class 
B digital device pursuant to Part 15 of the FCC Rules. These limits are 
designed to provide reasonable protection against harmful interference in a 
residential installation. This equipment generate uses and can radiate radio 
frequency energy and if not installed and used in accordance with the 
instructions may cause harmful interference will not occur in a particular 
installation. If this equipment does cause harmful interference to radio or 
television reception, which can be determined by turning the equipment off 
and on, the user is encouraged to try to correct the interference by one or more 
of the following measures:

Reorient or relocate the receiving antenna.
Increase the separation between the equipment and receiver.
Connect the equipment into an outlet on a circuit different from that 
to which the receiver is connected.
Consult the dealer or an experienced radio/TV technician for help.
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If necessary, the user should consult the dealer or an experienced radio/television 
technician for additional suggestions. The user may find the following booklet helpful: 
“Something About Interference.” This is available at FCC local regional offices. Our 
company is not responsible for any radio or television interference caused by 
unauthorized modifications of this equipment or the substitution or attachment of 
connecting cables and equipment other than those specified by our company. The 
correction will be the responsibility of the user. Use only shielded data cables with this 
system.

Intentional emitter per FCC Part 15
Low power, Radio LAN type devices (radio frequency (RF) wireless communication 
devices), operating in the 2.4 GHz Band, may be present (embedded) in your notebook 
system. This section is only applicable if these devices are present. Refer to the system 
label to verify the presence of wireless devices.

Wireless devices that may be in your system are only qualified for use in the United 
States of America if an FCC ID number is on the system label.

The FCC has set a general guideline of 20 cm (8 inches) separation between the device 
and the body, for use of a wireless device near the body (this does not include 
extremities). This device should be used more than 20 cm (8 inches) from the body 
when wireless devices are on. The power output of the wireless device (or devices), 
which may be embedded in your notebook, is well below the RF exposure limits as set 
by the FCC.

This transmitter must not be collocated or operate in conjunction with any other 
antenna or transmitter.

Operation of this device is subject to the following two conditions: (1) This device may 
not cause harmful interference, and (2) this device must accept any interference 
received, including interference that may cause undesired operation of the device.

Wireless devices are not user serviceable. Do not modify them in any way. 
Modification to a wireless device will void the authorization to use it. Contact 
manufacturer for service.

FCC Statement for Wireless LAN use:
“While installing and operating this transmitter and antenna combination the 
radio frequency exposure limit of 1mW/cm2 may be exceeded at distances 
close to the antenna installed. Therefore, the user must maintain a minimum 
distance of 20cm from the antenna at all times. This device can not be 
colocated with another transmitter and transmitting antenna.”
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FCC Part 68
This equipment compiles with part of the FCC rules. On the back of this equipment is 
a label that contains, among other information, the FCC registration number and ringer 
equivalence number (REN) for this equipment. If requested, this information must be 
provided to the telephone company.

This equipment uses the following USOC jacks : RJ11C

An FCC compliant telephone cord and modular plug is provided with this equipment. 
This equipment is designed to be connected to the telephone network or promises 
wiring using a compatible modular jack which is Part 68 compliant. See Installation 
Instructions for details.

The REN is used to determine the quantity of devices which may be connected to 
telephone line. Excessive RENs on the telephone line may result in the devices not 
ringing in response to an incoming call. In most, but not all areas, the sum of RENs 
should not exceed five (5.0). To be certain of the number of devices that may be 
connected to a line, as determined by total RENs, contact the local telephone company 
to determine the maximum REN for the calling area.

If the terminal equipment causes harm to the telephone network, the Telephone 
Company will notify you in advance that temporary discontinuance of service may be 
required. But if advance notice is not practical, the telephone company will notify the 
customer as soon as possible. Also, you will be advised of your right to file a complaint 
with the FCC if you believe it is necessary.

The telephone company may make changes in its facilities, equipment, operations, or 
procedures that could affect the operation of the equipment. If this happens, the 
telephone company will provide advanced notice in order for you to make necessary 
modifications to maintain uninterrupted service.

If trouble is experienced with this equipment (Modem) for repair or warranty 
information, please contact your local distributor. If the equipment is causing harm to 
the telephone network, the telephone company may request that you disconnect the 
equipment until the problem is resolved.

The user must use the accessories and cables supplied by the manufacturer to get 
optimum performance from the product.

No repairs may be done by the customer.

This equipment cannot be used on public coin phone service provided by the telephone 
company. Connection to party line service is subject to state tariffs.

The Telephone Consumer Protection Act of 1991 makes it unlawful for any person to 
use a computer or other electronic device, including fax machines, to send any message 
unless such message clearly contains in a margin at the top or bottom of each 
transmitted page or on the first page of the transmission, the date and time it is sent and 
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an identification of the business or other entity, or other individual sending the message 
and the telephone number of the sending machine or such business, other entity, or 
individual. (The telephone number provided may not be any number for which charges 
exceed local or long-distance transmission charges.)

In order to program this information into your fax machine, refer to your 
communications software user manual.
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Canada

Unintentional Emitter per ICES-003
This digital apparatus does not exceed the Class B limits for radio noise emissions from 
digital apparatus as set out in the radio interference regulations of Industry Canada.

Le présent appareil numérique n’émet pas de bruits radioélectriques dépassant les 
limitesapplicables aux appareils numériques de Classe B prescrites dans le règlement 
sur le brouillage radioélectrique édicté par Industrie Canada.

Intentional Emitter per RSS 210
Low power, Radio LAN type devices (radio frequency (RF) wireless communication 
devices), operating in the 2.4 GHz Band, may be present (embedded) in your notebook 
system. This section is only applicable if these devices are present. Refer to the system 
label to verify the presence of wireless devices.

Wireless devices that may be in your system are only qualified for use in Canada if an 
Industry Canada ID number is on the system label.

As a general guideline, a separation of 20 cm (8 inches) between the wireless device 
and the body, for use of a wireless device near the body (this does not include 
extremities) is typical. This device should be used more than 20 cm (8 inches) from the 
body when wireless devices are on.

The power output of the wireless device (or devices), which may be embedded in your 
notebook, is well below the RF exposure limits as set by Industry Canada. 

This transmitter must not be collocated or operate in conjunction with any other 
antenna or transmitter.

Operation of this device is subject to the following two conditions: (1) This device may 
not cause harmful interference, and (2) this device must accept any interference 
received, including interference that may cause undesired operation of the device.

To prevent radio interference to licensed service, this device is intended to be 
operated indoors and away from windows to provide maximum shielding. 
Equipment (or its transmit antenna) that is installed outdoors is subject to 
licensing.

Wireless devices are not user serviceable. Do not modify them in any way. 
Modification to a wireless device will void the authorization to use it. Contact 
manufacturer for service.
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Telecommunications per DOC notice
(for products fitted with an IC-compliant modem)

The Industry Canada label identifies certified equipment. This certification means that 
the equipment meets certain telecommunications network protective, operation, and 
safety requirements. The Department does not guarantee the equipment will operate to 
the users’ satisfaction.

Before installing this equipment, users should make sure that it is permissible to be 
connected to the facilities of the local telecommunications company. The equipment 
must also be installed using an acceptable method of connection. In some cases, the 
inside wiring associated with a single-line individual service may be extended by 
means of a certified connector assembly. The customer should be aware that 
compliance with the above conditions may not prevent degradation of service in some 
situations.

Repairs to certified equipment should be made by an authorized Canadian maintenance 
facility designated by the supplier. Any repairs or alterations made by the user to this 
equipment, or equipment malfunctions, may give the telecommunications company 
cause to request the user to disconnect the equipment.

Users should make sure, for their own protection, that the electrical ground connections 
of the power utility, telephone lines, and internal metallic water pipe system, if present, 
are connected together. This precaution may be particularly important in rural areas.

To avoid electrical shock or equipment malfunction do not attempt to make 
electrical ground connections by yourself. Contact the appropriate inspection 
authority or an electrician, as appropriate.

The Ringer Equivalence Number (REN) assigned to each terminal device provides 
an indication of the maximum number of terminals allowed to be connected to a 
telephone interface. The termination on an interface may consist of any combination of 
devices subject only to the requirement that the sum of the Ringer Equivalence 
Numbers of all the devices does not exceed 5.
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European Union

European Union CE Marking and Compliance Notices
Products intended for sale within the European Union are marked with the Conformité 
Européene (CE) Marking, which indicates compliance with the applicable Directives 
and European standards and amendments identified below. This equipment also carries 
the Class 2 identifier.

The following information is only applicable to systems labeled with the CE mark .

European Directives
This Information Technology Equipment has been tested and found to comply with the

following European directives:

EMC Directive 89/336/EEC with amending directives 92/31/EEC & 93/68/
EEC as per

– EN 55022 Class B

– EN 61000-3-2

– EN 61000-3-3

– EN 55024

Low Voltage Directive (Safety) 73/23/EEC as per EN 60950(A1/A2/A3/A4/
A11)

Radio and Telecom Terminal Equipment Directive 199/5/EC as per

– CTR21 (if fitted with a modem device)

– ETS 300 328 (if fitted with a 2.4 GHz band embedded wireless device)

– ETS 301 489-1 (if fitted with a 2.4 GHz band embedded wireless device)

– ETS 301 489-17 (if fitted with a 2.4 GHz band embedded wireless device)

European Radio Approval Information
(for products fitted with EU-approved radio devices)

This Product is a Notebook computer; low power, Radio LAN type devices (radio 
frequency (RF) wireless communication devices), operating in the 2.4 GHz band, may 
be present (embedded) in your notebook system which is intended for home or office 
use. This section is only applicable if these devices are present. Refer to the system 
label to verify the presence of wireless devices.
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Wireless devices that may be in your system are only qualified for use in the European 
Union or associated areas if a CE mark  with a Notified Body Registration Number 
and the Alert Symbol is on the system label.

The power output of the wireless device or devices that may be embedded in you 
notebook is well below the RF exposure limits as set by the European Commission 
through the R&TTE directive.

See 802.11b and 802.11g restrictions for specific countries or regions within 
countries under the heading “European Economic Area Restrictions” below.

Translated Statements of Compliance

This product follows the provisions of the European Directive 1999/5/EC.

European Economic Area Restrictions

Local Restriction of 802.11b/802.11g Radio Usage

[Note to integrator: The following statements on local restrictions must be published in 
all end-user documentation provided with the system or product incorporating the Intel 
PRO/Wireless 2200BG Network Connection product.]

Due to the fact that the frequencies used by 802.11b/802.11g wireless LAN 
devices may not yet be harmonized in all countries, 802.11b/802.11g products 
are designed for use only in specific countries or regions, and are not allowed 
to be operated in countries or regions other than those of designated use.

As a user of these products, you are responsible for ensuring that the products 
are used only in the countries or regions for which they were intended and for 
verifying that they are configured with the correct selection of frequency and 
channel for the country or region of use. Any deviation from permissible 
settings and restrictions in the country or region of use could be an 
infringement of local law and may be punished as such.

The European variant is intended for use throughout the European Economic Area. 
However, authorization for use is further restricted in particular countries or regions 
within countries, as follows:

General

European standards dictate maximum radiated transmit power of 100 mW effective 
isotropic radiated power (EIRP) and the frequency range 2400 – 2483.5 MHz.

Belgium
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The product may be used outdoors, but for outdoor transmissions over a distance of 
300m or more, a license from the BIPT is required.

This restriction should be indicated in the manual as follows:

Dans le cas d'une utilisation privée, à l'extérieur d'un bâtiment, au-dessus d'un espace 
public, aucun enregistrement n'est nécessaire pour une distance de moins de 300m. 
Pour une distance supérieure à 300m un enregistrement auprès de l'IBPT est requise. 
Pour une utilisation publique à l'extérieur de bâtiments, une licence de l'IBPT est 
requise. Pour les enregistrements et licences, veuillez contacter l'IBPT.

France

For Metropolitan departments:

2.400 - 2.4835 GHz for indoor use.

2.400 -2.454 GHz (channels 1 to 7) for outdoor use.

For Guadeloupe, Martinique, St Pierre et Miquelon, Mayotte:

2.400 - 2.4835 GHz for indoor and outdoor use.

For Reunion, Guyane:

2.400 - 2.4835 GHz for indoor use.

2.420 - 2.4835 GHz for outdoor use (channels 5 to 13)

European Telecommunication Information
(for products fitted with EU-approved modems)

Marking by the symbol  indicates compliance of this equipment to the Radio and 
Telecom Terminal Equipment Directive 1999/5/EC. Such marking is indicative that 
this equipment meets or exceeds the following technical standards:

CTR 21 – Attachment requirements for pan-European approval for connection to the 
analogue Public Switched Telephone Networks (PSTNs) of TE (excluding TE 
supporting voice telephony services) in which network addressing, if provided, is by 
means of Dual Tone Multi-Frequency (DTMF) signaling.

Although this equipment can use either loop disconnect (pulse) or DTMF 
(tone) signaling, only the performance of the DTMF signaling is subject to 
regulatory requirements for correct operation. It is therefore strongly 
recommended that the equipment is set to use DTMF signaling for access to 
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public or private emergency services. DTMF signaling also provides faster call 
setup.

This equipment has been approved to Council Decision 98/482/EEC—“CTR 21” for 
Pan-European single terminal connection to the Public Switched Telephone Network 
(PSTN).

However, due to differences between the individual PSTNs provided in different 
countries, the approval does not, of itself, give an unconditional assurance of 
successful operation on every PSTN termination point. In the event of problems, you 
should contact manufacturer Technical Support.
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WEEE SYMBOL INFORMATION

      Correct Disposal of This Product
 (Waste Electrical & Electronic Equipment)

(Applicable in the European Union and other European countries with separate 
collection systems)

This marking shown on the product or its literature, indicates that it should not be 
disposed with other household wastes at the end of its working life. To prevent possible 
harm to the environment or human health from uncontrolled waste disposal, please 
separate this from other types of wastes and recycle it responsibly to promote the 
sustainable reuse of material resources.

Household users should contact either the retailer where they purchased this product, 
or their local government office, for details of where and how they can take this item 
for environmentally safe recycling.

Business users should contact their supplier and check the terms and conditions of the 
purchase contract. This product should not be mixed with other commercial wastes for 
disposal.
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Using Your Documentation

Congratulations on your purchase of a notebook computer with the Windows® XP 
operating system. Whether you are new to using a portable computer or are an 
experienced user, this user’s manual can help you get the most from your computer.

Manual Documentation Conventions

Information Icons
Three icons and their associated messages appear in this manual. The information 
icons are placed before the step/information they apply to:

Warning:
Indicates the possibility of personal injury.

Caution:
Warns you of possible damage to equipment or data.

Note:
Informs you of special circumstances.

Technical Information:
Informs you of special requirements or limitations for use of item(s).

Keyboard Conventions
Keys that you need to press to perform certain functions are displayed in the manual in 
brackets. For example: 

<Ctrl> indicates the control key (Ctrl on the keyboard). 

If you need to press two keys at the same time, the key names are shown joined by a 
plus sign. For example:

<Fn+F8> means that you should press the Fn key and hold it and then press the F8 key.
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CD-ROM Device Naming Convention
In many installation programs you will have to get a program from the CD-ROM 
device. The program installation sequence assumes that the CD is drive d:\, however 
this is not always the case. The name of the CD-ROM drive is the letter following the 
letter assigned to your last HDD. For instance, if you have one HDD with two 
partitions, the HDD is drives C: and D: and the CD-ROM drive is then drive E.

Touchpad Conventions
You may be asked to click or double-click on items on the display screen. As a general 
note the touchpad actions act much in the same way as a wheel mouse, any differences 
are explained fully.

The object that needs to be clicked upon will be displayed in Bold text or shown in a 
small figure such as the “Start Button” shown on the right =>. 

Table 1.  Touchpad Click Conventions

Windows Conventions:
Almost all “Windows” programs will display the name/function of a button or 
icon if you place the touchpad pointer on the item you want information about.

Software User Documentation

Your computer is shipped from the factory with several software programs installed. 
The software may include its own online or printed documentation. Refer to the 
documentation or the Help options in the software for more information.

The figures and illustrations in this manual may not be identical to those on 
your system.

General Icon Note:
Some of the Icons used in Windows XP may be placed on the taskbar by 
selecting (ex: Place the volume icon in the taskbar) in the properties dialog 
box.

Action Process

Click Depress the touchpad left button and release

Double-click Quickly click the left touchpad button two times
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Getting Started

Introducing Your Computer

Front View

AVS Button (Optional)
For models with the AVS button , pressing this button will launch 
the Music, Photo and Movie Stations of AVStation. (p54)

Fingerprint Sensor(Optional)

You can turn the computer on with your fingerprint or login to Windows. For 
more information, refer to the additionally supplied manual. (Only for models 
with the fingerprint identification system.)

Touchpad 
Touchpad Button (p12)

Keyboard (p8)

LCD Panel

LCD Latch

Speaker

Multi Card Slot (Optional, p32)

Power Button

AVS Button
(optional, p54)

Status Indicators (p15)

Status Indicators (p15)

Microphone (p125)

Fingerprint Sensor (Optional)

Volume Control Button
(optional, p17)

Remote Control Sensor (Optional, p22) 
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Right View

Left View

CD Drive (optional, p24)

Wireless LAN Latch

Serial Port (Optional)USB Port (2.0)

PCMCIA Card Slot (p35)

Modem Port (p62)

Fan Vent

Microphone Jack

 Headphone Jack / S/PDIF Jack

Monitor Port

1394 Port
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Back View

Bottom View

Removing or disassembling the hard disk drive will void your warranty. To 
replace the hard disk drive, please contact your nearest Samsung Service 
Centre.

DC Jack USB Port (2.0)

Security Lock Port 
(p114)

LAN Port (p63)

TV Output Port (S-Video)

Battery Latches

Memory Compartment
(p112)

HDD Compartment Cover

Docking Connector

Battery
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Turning the Computer On and Off

To turn on the computer
1. Insert the battery and connect the AC adapter according to the Installation Guide.

2. Slide the LCD latch to the right and open the LCD panel.

3. Press the power button.

To turn off the computer
1. Click the start button ( ) on the taskbar.

2. Click Turn Off Computer.
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3. Click Turn Off.

If the computer has not turned off properly due to a system error, press 
<Ctrl>+<Alt>+<Delete>. When [Windows Task Manager] dialog box appears, 
click  Shut Down > Turn Off to turn off the computer. Your unsaved work may 
be lost/damaged.

If <Ctrl>+<Alt>+<Delete> keys do not operate either, press the power button 
for more than 4 seconds to turn off the computer. Your unsaved work may be 
lost/damaged. The next time you turn on your computer, a hard disk check will 
be performed, before Windows starts.
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Using the Keyboard

Your computer has an 88-key keyboard. By pressing designated key combinations, you 
can have access to all the key functions of a full-sized keyboard. 

The keyboard is supplied according to the corresponding country. Refer to the 
keyboard figure for the corresponding country.

Although the layout of the keys on your computer’s keyboard is different from 
that on a desktop computer’s keyboard, the keyboard feels like a full-sized 
keyboard when you use it. 

Embedded Numeric Keypad Screen Brightness and 
Volume Adjustment / 

Direction Keys

Windows 
Key

Function 
Key

Function & Special Purpose Keys

Application Key

<United Kingdom>
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The keys on the keyboard can be grouped into the following categories:

Full-sized Alphanumeric typewriter keys are arranged like a standard 
typewriter keyboard and are used for text entry. The Windows keys on either 
side of the spacebar open Windows menus and perform other special functions. 

Function keys, when pressed together with the <Fn> key, enable special 
functions.

Cursor and Screen control keys move the cursor. They may perform other 
functions, depending on your software.

To clean the computer keyboard, use slightly damp cotton swabs. Scrub the keys and 
the surface around the keys. 

Do not allow liquid to drip into the keyboard or you may damage the keyboard.

Embedded Numeric Keypad Screen Brightness and 
Volume Adjustment / 

Direction Keys

Windows 
Key

Function 
Key

Function & Special Purpose Keys

Application Key

<United States>
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Using the Numeric Keypad
Your keyboard includes a numeric keypad, which is a group of keys that you can set to 
type numbers and mathematical symbols, such as the plus sign. A number or symbol 
on the corner of each keypad key shows its numeric function.

Press <Fn+Num Lock> to turn on the embedded numeric keypad. The numeric 
functions of the keypad are enabled and the Num Lock LED turns on. ( "Reading the 
Status Indicators" on page 15 for the location of the Num Lock LED.) 

While the numeric functions are enabled, you can temporarily return a key to its normal 
function by pressing the key and the <Fn> key. For example to type the letter m, press
<Fn+M>, this operation displays the letter m.

To turn the numeric keypad off, press <Fn+Num Lock> again. The Num Lock LED 
turns off. 

Num Lock LED
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Using Special Function Keys
The function key activates special functions when it is pressed in combination with 
another keys.  

When you press a function key combination, the system sound may be 
temporarily muted.

<Fn> Key 
Combinations

Key Name Key Function

<Esc/ > Standby Places the computer into standby mode. To resume from 
standby mode, press the power button. (p103).

<F2/ > Gauge Shows the remaining battery charge.
Appears only when the Samsung Display Manager program 
is installed.

<F4/ > LCD/CRT Switches the display between the LCD and external display 
device when an external display device is connected. (p100)

<F5/Backlit> Backlight Turns the LCD on and off.

<F6/Mute> Mute Turns the audio output on and off.

<F7/ SRS> SRS This feature enables you to experience more stereophonic 
sound. You can select one of the following modes by 
pressing the button. 

Note. WOW XT ON Mode: Select to listen to music.
         TRUSURROUND Mode: Select to watch a movie. 
         SRS OFF Mode: Switches off the SRS function.

The SRS function is only supported through the built-in 
speaker of the computer and the headphones. It is not 
supported through the S/PDIF port.

<F9/ > Touchpad Turns the touchpad function on and off.

<F10/ > Etiquette Mode You can select Etiquette Mode when you need a tranquil 
work environment.

<F11/Num Lock> Number Lock Enables the numeric keypad. (p10)

<F12/Scroll> Scroll Lock Scrolls the screen up and down while the cursor position 
does not change in some applications.

< / > Volume Down Decreases the audio volume.

< / > Volume Up Increases the audio volume.

< / > Brightness Up Makes the LCD screen brighter.

< / > Brightness Down Makes the LCD screen dimmer.
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Using the Touchpad

In Windows, you always see a small graphical image on the screen that indicates the 
location where you can take the next action. This image is called a pointer, and is 
usually displayed in arrow shape ( ) or ‘I’ shape ( ).

The touchpad on your computer allows you to move the pointer on the LCD screen, 
just like a mouse that is used with a desktop computer. The touchpad buttons allow you 
to take actions with the pointer, such as selecting an item or executing a command. 

Locking the touchpad

You can lock the touchpad and use only the keyboard and mouse. To lock the 
touchpad function, press the <Fn>+<F9> key combination.

Touchpad Buttons

Touchpad
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You can perform various actions with your touchpad as described below.
d

Action Function Process

Move Move the pointer Place your finger on the touchpad 
and slide your finger to a 
destination.

Click Select an object, open a menu, or 
execute a button

Place the pointer over an object, 
then press left touchpad button 
once.

Or, place the pointer over an 
object, then tap the touchpad once 
with your finger.

Double-Click Launch a program or open a file Place the pointer over an object, 
then quickly press left touchpad 
button twice.

Or, place the pointer over an 
object, then quickly tap the 
touchpad twice with your finger.

Right-Click Display a short cut menu Place the pointer over an object, 
then press right touchpad button 
once.

Drag Move an object, or select an area 
or multiple objects

Drag and drop a part to the 
required place.
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Please use the touchpad only with your finger. Using sharp devices may 
damage the touchpad.

Operating the touchpad or touchpad button while starting your system may 
increase the time required for starting Windows.

Scroll Display upper/lower/left/right part 
of the content within a window

(Applicable to certain programs 
only)

Place your finger on the right edge 
or bottom edge of the touchpad 
and move vertically or horizontally.

Action Function Process
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Reading the Status Indicators

Shows the operating status of the computer.

Num Lock Turns on when the numeric keypad is activated.

Caps Lock Turns on when all alphabet characters you type will be in upper case.

Scroll Lock Turns on when it is set to scroll the screen up and down while the cursor 
position does not change in some applications.

Hard Disk Drive / 
CD-ROM Drive Blinks when the hard disk drive or CD-ROM drive is in operation.

Wireless LAN Turns on when the wireless LAN function is enabled. (This light does not 
operate for models without a wireless LAN.)

Battery

Turns Light Green - when the battery is fully charged, or when the battery is 
not installed.
Turns amber - when the battery is being charged.
Blinks - when the battery is not properly installed.

Power Turned On - when the computer is turned on.
Blinks - when the computer is in Standby mode.
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Adjusting LCD Brightness

There are 8 levels of LCD brightness (1: Dimmest ~ 8: Brightest). 

To adjust using keyboard
Press <Fn>+< > or <Fn>+< > keys from the keyboard to adjust LCD brightness.

Whenever you turn the system on or change the power source the brightness level 
changes according to the settings.

when operating on AC power:        Brightness Level 8

when operating on battery power:   Brightness Level 1

Adjusting the brightness using the Battery Manager
    You can adjust the screen brightness using the Battery Manager. (p110)

Maintaining your LCD brightness settings after turning the system off 
and on
1. Turn the system on. When the Samsung Logo appears, press the <F2> key 
to enter Setup.

2. In the Boot menu, change the Brightness Mode Control option to User 
Control.

3. Save the settings and exit Setup.

- When using the Battery Manager, only the screen brightness set in 
'Customized Mode' is maintained.

To save the battery charge
When your computer is operating on battery power, adjusting the LCD 
brightness level to dimmer diminishes the battery power consumption.

Bad pixels in the LCD
The limits of the LCD manufacturing technology allow a maximum of 10 
abnormal or bad pixels, which do not affect system performance. This system 
may have the same level of abnormal or bad pixels as any other company’s 
products.

Maintenance Instructions
When cleaning the LCD panel, use only computer specific cleaners on a soft 
cloth, and lightly wipe in one direction. 
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Adjusting the Volume

Adjusting the Volume using the Volume Control Button
(Only for Some Models).

Adjust the volume by using the Volume Control Button ( , )

To adjust using keyboard
Press <Fn>+< > or <Fn>+< > from the keyboard.

To adjust using volume adjustment program
Click the Volume icon( ) on the taskbar, and move the Volume slider to a desired 
level.

For advanced volume control options, double-click the Volume icon( ), and adjust 
the volume level in the volume control program.

When you turn the system on, a booting noise may occur.
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Introducing Windows

Understanding the Desktop

The desktop is the working area on the computer. It consists of the large workspace and 
a taskbar at the bottom.

Start Button           Opens the Start menu.

Taskbar          Displays programs that are currently running. Frequently used 
icons can be placed here.

Recycle Bin                    Deleted files or folders are sent here.

Language Bar Switches text input language.

Start Button

Taskbar

Shortcut
Icons

Start Menu

Recycle Bin
Language Bar

System Tray with Clock
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Understanding the Start Menu

The Start menu includes everything that is required to start Windows. From the Start 
menu it is possible to run a program, open a file, assign system users with Control 
Panel, receive support by clicking Help and Support, and search desired items from the 
computer or Internet by clicking Search.

My Computer
Displays the contents of the hard disk, the CD-ROM drive, the network 
drive(s), and floppy disks. It can also be used to search and open files 
and folders.

Control Panel Enables users to configure settings on the computer.

Help and Support Provides on-line help, information on Windows and troubleshooting.

Search Enables users to search for information in files or the Internet.

Run Run programs or documents.

My Computer

Control Panel

Help and Support

Start Button

All Programs

Frequently used programs
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Understanding a Window

A window is the basic component in working with the computer. The My Computer 
window, which is a window for the computer's hard drive, will be used as an example 
here to show the basic composition of a window.

Click Start > My Computer.

Double-click the hard drive (local disk) to view internal folders and files stored in it. If 
the contents do not appear, click Show the contents of this folder.

What is a drive?
A storage device in which files and folders are saved in, and read from.

What is a folder?
A folder is used to group and manage files systematically, and may include 
files in sub-folders. It is similar to a bookshelf.

What is a file?
A file is a document or various kinds of material that is generated as a result 
of program operation. It is also called data.

To view the entire structure of the drive
Click the Folder icon in the taskbar to view the entire structure. Click again to 
return to the Quick Task Window.

Close Button

Maximize Button

Minimize Button

Folders

Files

Title Bar
Menu Bar

Quick Task
Window

Folder Icon

Double-click 
Shared 
Documents or 
Local Disk.
You can see files 
and folders.
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Help and Support Center

Help and Support Center provides references and troubleshooting information 
regarding computer use.

Click Start > Help and Support.

Please refer to help and support centre before calling the Samsung helpline.

Windows XP Tour

You can tour elementary functions provided by Windows XP.

Click Start > Tour Windows XP.

Or click Start > All Programs > Accessories > Tour Windows XP.

Click on the topics to find out about important functions of Windows XP.
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Using the Remote Control (Optional)

Using the remote control for the computer is described below. To use the remote 
control, install the supplied battery into the remote control first.

 Installing Battery

.

Move the groove ( ) on the cover to the  position by using a coin and open the 
battery cover by turning it clockwise.

Move the groove ( ) on the cover to the 
( ) position by using a coin and open the 
battery cover. (To open the cover, turn it 
counterclockwise.)

+

Insert the battery so that the positive pole (+)
of the battery is towards the inside of the 
cover
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 Remote Control Buttons

Buttons indicated by (*) do not work in some applications.

When pressing the Power / Standby Button in Windows, the computer enters 
Standby mode. The computer will not shut down.

 Remote Control Operating Range
The valid distance for the remote control is determined by the user environment. It is 
recommended to use the remote control within 3 meters and a 45 degree angle from the 
remote control sensor on the device.

When the remote control is not being used, keep the remote control in the 
PCMCIA slot. To keep the remote control in the slot, insert the remote control 
into the slot so that the Remote Control Signal Transmitter faces outward.

Remote Control Signal Transmitter
Power / Standby Button

Press to turn the computer
on or to enter Hibernation.

Playback Control Button

Direction Button*
Press to move to an item.

BACK Button*
Press to return to the

previous step.

MUTE Button
Press to mute the sound.

AVS Button  (p54)
- When the computer is turned off, AVStation 
now is launched.
-  When the computer is turned on, AVStation 
premium Viewer is launched.

ENTER Button
Press to execute the selected item.

Volume Control Button
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Using the Computer

Using the CD Drive

You have one of following drives installed in your computer.

A CD-ROM drive is optional. For more detailed product specifications, refer to 
the product catalog.

To insert a CD
1. Press the eject button on right side of the CD drive.

2. When the tray slides out, place a CD onto the tray with the label facing up, and 
push the CD down until it clicks.

3. Push the tray in gently until it clicks. 

CD-ROM Drive Reads CDs.

DVD-ROM Drive Reads CDs/DVDs.

RW-Combo Drive Reads a CD/DVD and writes a CD.

DVD Super Multi Drive Reads CD/DVDs and writes data to CD/DVDs. Supported DVD types 
include DVD R, DVD RW and DVD-RAM.

Emergency Eject Hole

Eject Button

CD Access LED
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To eject a CD
1. Stop any process that accesses the CD drive and ensure the CD access LED is 

turned off.

2. Press the eject button on right side of the CD drive.

3. When the tray slides out, remove the CD from the tray.

4. Push the tray in gently until it clicks. 

If you remove the CD when the CD access LED is on, the disk and the data in 
it may be damaged.

Emergency Eject Hole
To eject a CD when the CD drive is not working or the computer is turned off, 
unfold a paperclip, and insert the unfolded end of the clip into the emergency 
eject hole (located next to the eject button) and press until the CD tray opens.

To clean a CD or DVD title
Clean the disc with a soft clean cloth by wiping from the center outwards.
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To use the Windows Media Player
Window Media Player enables you to play and manage audio and video files.

To launch the Windows Media Player, click Start > All Programs > Accessories > 
Entertainment > Windows Media Player.

Running the program the first time displays the set up screen. Define the settings 
according to the instructions displayed on the screen.

When you complete the settings, the following screen appears.

To view detailed information on how to use Windows Media Player 

Run Windows Media Player and right-click over the Function Taskbar and 
select Help > Windows Media Player Help.

To play a video CD
If a video CD does not run automatically, follow these steps.

1. Insert a video CD into the CD drive.

2. When the CD drive window appears, double-click the MPEGAV folder.

3. Double-click the .dat file.

4. When the [Caution] dialog appears, click Open With.

5. Select “Select the program from a list” and click OK.

6. Select the Windows Media Player, and click OK. The video starts playing.

Features

Playback Control Area

Playlist
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Above procedure applies only to the video CDs that has a .dat file as the 
execution file. Playing procedure may be different according to video CDs.

To write data on a CD (Optional)
If your computer has CD-RW functionality, you can copy data to a blank CD or create 
an audio CD.

You cannot write to a CD that already has data in it.

1. Insert a blank CD into the CD drive.

2. On the [CD Drive] dialog, select Open Writable CD Folder and click OK. The 
CD drive window appears.

3. Click Start > My Computer.

4. In My Computer window, select files and folders to copy, then drag and drop them 
onto the CD drive window. 

My Computer window

5. Click Write these files to CD.

CD drive window

4. Drag and drop folders or 
files to copy.
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5. Click Write these files to CD in the CD drive window.

6. When the CD Writing Wizard appears, enter the CD label, and click Next. The 
data begins copying.

7. When copying is completed, a ‘completed’ message appears and the CD drive 
window opens automatically.

For more information on writing CDs
Click Start > Help and Support. Type “CD copy” in the search field, and click 
the Search icon ( ).

To Burn an Audio CD

Run Windows Media Player and right-click over the Function Taskbar and 
select Help > Windows Media Player Help.

Select Using the Player > Using CDs, DVDs and VCDs > Using CDs > 
Burning your own CDs > To burn your own CD to see detailed information.
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Enjoying Home Theater (S/PDIF Port) 

Your computer supports 5.1 channel output, which is a basic function for home theater 
systems, and DVD drives. It provides 3D surrounding sound and vivid screen.

What is a home theater system?
Home theater system usually consists of a TV, DVD, 5.1 channel speaker, and 
digital amp and provides a high-resolution screen (MPEG2) and 3D 
surrounding sound (Dolby 5.1 or DTS). With a home theater system, you can 
enjoy a vivid screen and sound in your home as if you are in a movie theater.

The following devices are required to enjoy a home theater system.

To use home theater system, complete the following procedures:

Step 1. Connect 5.1 channel speaker system to your computer.

Step 2. Configure digital sound output on the computer.

Step 3. Enable S/PDIF output on the DVD program.

5.1 channel speaker system (amplifier, speakers, connection cables) Purchased separately

DVD drive and DVD playing program on the computer Optional

DVD title that supports 5.1 channel Purchased separately
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Step 1. Connect 5.1 channel speaker system to your computer

1. Connect the S/PDIF jack of the system and a 5.1 channel amplifier.

2. Connect speakers to the amplifier. (Refer to speaker’s manual.)

3. To view through a TV, connect the TV and change the current display device to 
TV in the Display Properties. ( "Using External Display Devices" on page 100)

Step 2. Setting the Sound to Digital Sound Output on the Computer

Since the sound of the computer is set to Digital Output by default when purchasing 
the computer, additional settings are not required. You can confirm the setting as 
follows.

1. Double-click the Volume Control ( ) icon in the notification area of the Taskbar 
and select Options > Advanced Controls.

2. Click the Advanced button below the Master Volume and check if the 1 Disable
Digital Output item is unselected.
The option must be unselected for sound to be output in digital format.

Front Left Speaker

TV

Surround Left Speaker Surround Right Speaker

Center 
Speaker

Front Right Speaker

Digital Amplifier

Computer

Sub 
Woofer
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Step 3. Enable S/PDIF output on the DVD program

To use 5.1 channel speakers, you need to install the CyberLink Power DVD program 
from the CyberLink DVD Solution Installation CD (or System software Media) 
provided with your computer, then change the settings as per the following.

The CyberLink PowerDVD program is optional and may not be provided depending 
on the model.

1. Run CyberLink Power DVD program and click the Configuration icon ( ).

2. On the Audio tab, set the Audio Output setting to “Use SPDIF” and click OK.

Now, you can enjoy home theater using DVD titles.

To control volume for your 5.1 channel speaker, use the control on the digital 
amp. (Please refer to the speaker manual.)
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Using the Multi Card Slot (Optional)

Using the Multi Card Slot, you can use memory cards such as a Memory Stick, 
Memory Stick Pro, SD Card, MMC, or xD Card. A memory card is used as a 
removable disk and is useful for exchanging data between a computer and a digital 
device such as a digital camera.

A multi-card slot is optional and is not provided for some models.

Restrictions when Using Memory Cards

You can use memory cards for storing data only. Copyright protection function 
is not supported.

To insert and use a memory card

Remove the Slot Protector first, before using the Multi Card Slot. Press the end 
of the Slot Protector lightly, and remove the Slot Protector when it pops up.

You should insert the memory card with the writing on the card facing 
downwards. 
Inserting wrong side up may cause damage in the memory card and the 
computer.

Memory Stick SD Card Memory Stick Pro MMC xD Card
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1. Insert a memory card into the Multi Card Slot.

2. Click Start > My Computer. The inserted memory card is displayed.

3. You can write data to the memory card. If the memory card is not formatted yet, 
format the memory card before use.

Since the memory card may be easily mislaid when moving your computer, 
keep the memory card separately.

To remove a memory card
1. Press the end of the memory card softly to pop it outward.

2. If the card pops out with a clicking sound, remove the card from the system. 

Example : Memory Stick
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To format a memory card
You can use a memory card after the format operation. The procedures to format a 
memory card are described below.

Since format operation deletes all data in the memory card, please make sure 
that there is no important data in the memory card before formatting.

To protect the data in the memory card
Set the write protection tab of the Memory Stick or SD memory card to the 
Lock position.

1. Click Start > My computer.

2. Press the right touchpad button on the memory card drive, and select Format from 
the pop-up menu.

3. Click Start to start the format operation.

To use a memory card in both the computer and other digital device such as 
digital camera, it is recommended to format the memory card in the digital 
device. If you format the memory card in the computer, you may have to format 
the memory card in other digital device again to use the memory card in the 
digital device.
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Using the PCMCIA Card Slot

Various different functions can be added by inserting PCMCIA cards into the system. 
This system supports 16/32 bit, type I or II PCMCIA card types.

The PCMCIA card slot does not support a ZV card or a PCMCIA III card.

To insert a PCMCIA card

Before using the PCMCIA slot, remove the slot protector.
Push the eject button of the PCMCIA card slot once to pop it out. Push the 
button again to eject the slot protector.

1. Insert a PCMCIA card into the PCMCIA card slot on the side of the computer.

Ensure that the PCMCIA card is inserted the correct way, as incorrect insertion 
will damage the PCMCIA card slot.

2. Windows automatically installs the necessary driver for the card. If there is no 
available driver found by Windows, you have to install the driver using a disk 
supplied with the card. 

Eject Button
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To remove a PCMCIA card
1. Double-click Safely Remove Hardware icon ( ) on the taskbar.

2. On the [Safely Remove Hardware] dialog box, select the appropriate PCMCIA 
card and click Stop.

3. When [Stop a Hardware Device] dialog box appears, click OK.

4. Click Close to close the [Safely Remove Hardware] dialog box.

5. Push eject button of the PCMCIA card slot once, and the button pops out.

6. Push the button again to eject the PCMCIA card.
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Using EasyBox

Use EasyBox program to make use of Windows' complicated function easily and 
conveniently.

Learn about EasyBox
Double-click the EasyBox( ) icon on the desktop.
(Or select Start >  All Programs > Samsung > EasyBox >  EasyBox.)

System: System management features are available, including disk 
defragmenter, disk cleanup, computer scheduling and system restore. 

BIOS: In windows-based mode, you can recover the BIOS defaults and change 
the boot sequence. 

Desktop: Desktop management features include changing the font size, 
executing a magnifier function, the start menu settings and managing the quick 
launch icons on the taskbar. 

Security: Here you can configure the security settings supported by Windows 
XP SP2. You can also change the configuration of the firewall settings, 
Windows automatic updates and blocking pop-ups when connected to the 
Internet.

Plus Tip: This is a collection of additional Windows functions that are useful 
for system management. (Offering shortcut descriptions of Windows, 
configuring network sharing and opening local folder sharing, etc.)
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Using EasyBox
The Security management function will be used as an example here to show the 
function of Easybox

 Configuring Firewall

The Windows Firewall prevents unauthorized users from gaining access to your 
system via the network or the Internet. 

1. Click Start > All Programs > Samsung  > EasyBox > EasyBox.

2. Click Security from the top menu bar.

3. Select Windows Firewall Settings from the Security menu on the left. 

4. Select a firewall level. 

5. Click Apply.

Click the User Setting button for advanced features, including exceptions and 
permissions. 
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Using Samsung Update Plus

Samsung Update Plus is software that examines and updates Samsung software and 
drivers installed on your Samsung computer to the latest version. To use Samsung 
Update Plus, your computer has to be connected to the Internet. 

 To Update Samsung Software and Drivers

1. Select Start > All Programs > Samsung  > Samsung Update Plus > Samsung 
Update Plus.

If this is the first time you are running the program, a window will appear asking 
you if you agree to the agreement in the window. 
Click Agree to use this software. 

2. Click Search for and Install Updates and click the Search for New Updates 
button.  

3. If there are available software or driver updates for your computer, the available 
updates will be listed. Select the required updates from the list and click Install
Update to start the update.

  (The update list on the screen may differ depending on the computer model.) 
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Updates that must be installed separately.

If you select Install as an update item that must be installed separately, a 
message appears informing you of this. Follow the instruction message to 
correctly install it. 

Automatic update items display  

By default, your computer is configured to automatically search for updates. If 
there is a new update available, this is notified in the notification area. Click the 
balloon help icon in the notification area. Here you will be able to find the latest 
available updates.

To change the automatic update settings, click the Configuration button in 
Figure 2 and change the settings.

Samsung Update Plus does not provide updates for additionally installed 
software and device drivers. 
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Using AVStation premium

AVStation premium is an integrated multimedia program that enables users to enjoy 
music, photographs, video, movies, etc. all with a single program.

Before You Start!

AVStation premium is optional and may not be provided depending on the 
model.

The screens used in this manual may differ from actual screens according 
to the program version.

TV Station is only available for systems supporting the TV function.

For detailed usage, refer to the program help.

Start and Screen Layout
To launch the program, select Start > All Programs > Samsung > AVStation 
premium > AVStation premium.

Alternatively double-click the AVStation premium icon ( ) on the Desktop.

MUSIC

You can play a music file or an audio CD.

PHOTO

You can view or edit a photograph (image), and also view the photographs through a 
SlideShow.

Station Bar
 Menu Bar
 Library
 Exit
Press the Exit button to exit 
the program.



42  Users Manual

MOVIE

You can play a video (movie) file or a DVD/VCD title.

MUSIC Station
Launch AVStation premium and click MUSIC on the Station Bar.

What is EDS (Enhanced Digital Sound)?

EDS (Enhanced Digital Sound) is a sound quality enhancement technology 
developed by Samsung Electronics. You can listen to clearer sound if you 
enable the EDS function when playing music or video on AVStation premium.

MUSIC Menu Bar
 Station Bar
MUSIC Library

 Register a File
 Playlist
Playlist Control Buttons

 Play Control Buttons
 Volume Control
 Play Options
 EDS Setting Button
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Playing an Audio CD

The procedures to play an audio CD are described below.

1. Launch AVStation premium and insert an audio CD into the CD drive.

2. In the Audio CD window, select Play Audio CD using Samsung AVStation and 
click the OK button.

3. The tracks on the audio CD are displayed in the Playlist and the first track is 
automatically played.

If an audio CD is already in the CD drive, double-click the album title in the 
Audio CD folder of the Library and add the tracks to the Playlist. The tracks 
added to the Playlist are played.
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Playing a Music File

If a music file is registered to the MUSIC Library, you can easily play the music file.

For the procedures to register tracks to the Library, refer to (p45).

1. Move to MUSIC Station and double-click on All Music.

2. Double-click a music file. The file is added to the playlist and played.

Play a Track not registered to the Library

Click File > Open, select a music file to be played and click Open. The selected 
track is registered to the Library and played.

Creating My Playlist

My Playlist is a personal album with which you can collect, manage and play 
your favorite music files. For the procedures to create My Playlist, refer to the 
descriptions of MUSIC Station in Help.
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Adding Music Files to the Library

MUSIC Library is a library holding music files used by MUSIC Station. The 
procedures to add music files saved on the computer to the Library are described 
below.

You can add files, folders or search and add files. As an example, the procedures to add 
a folder are described below.

1. Click on the Register a File ( ) button below the Library and click on Add by 
Folders.

2. Select a folder which included music files and click the OK button. The music files 
in the folder are added to the Library.

The tracks used in AVStation are automatically added to the Library.
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PHOTO Station
Launch AVStation premium and click PHOTO on the Station Bar.

Viewing an Image

The procedures to view images registered to the PHOTO Library one by one and 
through a SlideShow are described below.

For the procedures to register image files to the Library, refer to (p49).

1. Move to PHOTO Station and double-click on All Images.

2. Click on a folder which includes images, and the images in the folder are displayed 
in the Image Viewer window.

PHOTO Menu Bar
 Station Bar
PHOTO Library

 Register a File
 Image Viewer Tab
Image Editor Tab

 Move to a Higher-Level Folder
 Preview/Zoom-in

Image Viewer Window

Image
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3. Double-click on an image. The selected image is zoomed in on.

Viewing an Image not registered to the Library

Click File > Open, select an image file to view and click Open.

The selected image file is registered to the Library and displayed in the Image 
Viewer window.

Viewing an Image in Full Screen or through a SlideShow.

Click the Full Screen ( ) button or SlideShow ( ) button below the 
Image Viewer window.

To return to the Image Viewer window, press the <Esc> key or double-click on 
the screen. 

Watching a SlideShow while Listening to Music

To watch a SlideShow while listening to music, play music from MUSIC Station 
and run SlideShow.

Setting an Image as the Background.

Click the Set as Background button below the Image Viewer window. The 
selected image is set as the Desktop background.
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Editing an Image

You can change the shape of an image, edit an image or apply special effects to an 
image. The image editor functions are described below.

1. Select an image to edit in the Image Viewer window, and select the Image Editor
tab. The Image Editor screen appears.

The Image Editor screen consists of an Image Workspace window and 3 Tool 
tabs.

2. Edit the image using the Shape, Edit and Effect tools.

Shape tool: Change the shape of an image through cut, resize.

Edit tool: Draw a line, add some clip art or enter letters.

Effect tool: Apply various effects to an image.

3. When finishing editing an image, click the Save Edited Image ( ) button 
below the Image Editor window. The edited image is saved.

Image Workspace

Zoom In / Zoom Out

Tool Tabs
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Adding Images to the Library

The PHOTO Library is a library holding image files to be used by PHOTO Station. The 
procedures to add image files saved on the computer to the Library are described 
below.

You can add files, add folders or search and add files. As an example, the procedures 
to add folders are described below.

1. Click the Register a File ( ) button below the Library and click on Add by 
Folders.

2. Select a folder which includes image files and click the OK button. The image files 
in the folder are added to the Library.

The image files used in AVStation are automatically added to the Library.



50  Users Manual

MOVIE Station
Launch AVStation premium and click on MOVIE on the Station Bar.

What is EDI (Enhanced Digital Image)?

EDI (Enhanced Digital Image) is a visual quality enhancement technology 
developed by Samsung Electronics. You can view a clearer and sharper 
picture by enabling the EDI function when watching TV or playing a video on 
AVStation premium.

However, some TV tuners and graphics cards are not supported by EDI.

For information on EDS (Enhanced Digital Sound), refer to p42.

MOVIE Menu Bar
Station Bar
MOVIE Library
Register a File
Video Play window
Play Control Buttons
Volume Control
EDS Setting Button (p42)
EDI Setting Button
Capture Button
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Playing a DVD

The procedures to play a DVD title are described below.

To play a DVD title, DVD playing software (e.g. CyberLink PowerDVD) must 
be installed. Install the DVD playing software first.

1. Launch AVStation premium and insert a DVD title into the DVD drive.

2. In the 'What do you want Windows to do?' window, select Play DVD Video 
using Samsung AVStation and click the OK button.

3. The DVD title is played.

If a DVD title is already in the DVD drive, double-click the DVD title in the DVD
/ VCD folder of the Library. The DVD title is played.



52  Users Manual

Playing a Movie(Video) File

The procedures to play a video file registered to the MOVIE Library are described 
below. For the procedures to register files to the Library, refer to p53.

1. Move to MOVIE Station and double-click All Movies.

2. Double-click a video file. The file is played.

Playing a Video File not Registered to the Library

Click File > Open, select a video file to be played and click Open. The selected 
file is registered to the Library and played.

Playing a Video File in Full Screen

1) Double-click on the current playback screen. 

2) The video is played in full screen. In full screen, move the mouse pointer to 
the bottom of the screen to show the Play Control bar.

To play at the default screen size, press the <Esc> key or double-click on the 
screen.

Capturing the Video Screen

Click on Capture Current Screen ( ) below the Play window when the 
desired image appears on the screen and click the OK button.

Captured images are saved in the C:\Program Files\Samsung\AVStation 
Premium 3.7\Data\Captured Images folder.

In addition, you can view captured images in the PHOTO Station > Captured 
Images folder.
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Adding Videos to the Library

The MOVIE Library is a library holding video files to be used by MOVIE Station. The 
procedures to add video files saved on the computer to the Library are described below.

You can add files, add folders or search and add files. As an example, the procedures 
to add folders are described below.

1. Click the Register a File ( ) button below the Library and click Add by 
Folders.

2. Select a folder which includes video files and click the OK button. The video files 
in the folder are added to the Library.

The video files used in AVStation are automatically added to the Library.



54  Users Manual

Using AVStation now / AVStation premium Viewer

Using these programs, you can play music, photographs, video and movies in full 
screen. You can enjoy multimedia using AVStation now when the computer is off and 
using AVStation premium Viewer when the computer is on.

Before You Start!

AVStation now and AVStation premium Viewer are optional and may not 
be provided depending on the model. 

AVStation now Restrictions

You can only use AVStation now when the computer is turned off.

Using AVStation now, you can play files registered to the AVStation premium 
Library, saved to My Computer, and saved on the multi-card slot (optional). 
(For the procedures to register files to the Library, refer to p45, p49 and p53.)

If you define a login password for a Windows user account or if the folder is 
protected, you cannot play the files in the folder on AVStation now.

AVStation premium Viewer Restrictions

Using AVStation premium Viewer, you can only play files registered to the 
AVStation premium Library. (For the procedures to register files to the Library, 
refer to p45, p49 and p53.)

Since the screen layout and usage of the two programs are similar, the 
manual describes the functions and screens on the basis of AVStation
now.

The screen figures may differ from actual ones depending on the program 
version.

TV Station is only available for systems supporting the TV function.

The AVS button ( , , ) is only provided for some computer models 
and clicking the AVS button ( , , ), launches the Music, Photo and 
Movie Stations immediately.
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Start / Exit AVStation now

Starting

Press the AVS button ( , , ) of the computer when the computer is turned off.

Exiting

Move the mouse pointer to the top screen and click the Exit ( ) button.

Alternatively press the Power button of the computer.

For models with the remote control, press the Power / Standby button on the 
remote control to exit.

Start / Exit AVStation premium Viewer 

Starting

Select Start > All Programs > Samsung > AVStation premium > AVStation 
premium Viewer from Windows.

Alternatively press the AVS button of the computer from Windows.



56  Users Manual

Exiting

Move the mouse pointer to the top of the screen and click the Exit ( ) button.

Screen Layout

MUSIC

You can play a music file or audio CD.
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PHOTO

You can view a photograph or image file one by one or in a SlideShow.

MOVIE

You can play a video, DVD or VCD title.

Settings

You can set the Music, Photo and Movie settings.

To move to the start screen while using the program, press the AVS
 button or <ESC> key.

Alternatively, move the mouse pointer to the top left in the current screen and 
click the AVStation icon .

Using the Remote Control 
The basic uses of the remote control are described below. For more detailed 
information on the button functions, refer to "Using the Remote Control (Optional)" on 
page 22. 

A remote control is optional and is only provided for some models. 

Starting the Program

Click the AVS button on the remote control. 

Press the AVS button to move to the start screen while using the program.

Moving to an Item

Press the Direction buttons on the remote control to move to an item.

Selecting or Running an Item

When an item is selected, press the ENTER button on the remote control.

Moving to the Previous Screen

Click the BACK button on the remote control.

Exiting the Program

1. Press the AVS button on the remote control to move to the start screen.

2. Press the  button to move to the Exit button ( ) and press the ENTER
button.
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In AVStation now, you can also exit the program by pressing the Power / 
Standby button on the remote control. 

MUSIC Station
The procedures to play a music file or an audio CD are described below.

Playing a Music File

The procedures to play a music file registered to the MUSIC Library are described 
below. (For the procedures to register files, refer to p45.)

1. Launch AVStation now and click on Music.

2. Click on All Music and double-click a file in the right pane.

The music file is played.

Playing an Audio CD

1. Launch AVStation now and insert an audio CD into the CD drive.

2. In the AVStation now start screen, click on Music.

My Computer
This only appears in 
AVStation now. You can 
manually find and play 
files on My Computer or 
the multi card slot.
All Music
Playlist Window
Music File
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3. Double-click the Audio CD in the left pane and double-click on an album or music 
file in the right pane. The selected music file is played.

PHOTO Station
The procedures to view images registered to the PHOTO Library one by one and 
through a SlideShow are described below.

(For the procedures to register image files to the Library, refer to p49.)

1. Launch AVStation now and click on Photo.

2. Click on All Images and double-click on an image file in the right pane.

My Computer
This only appears in 
AVStation now. You can 
manually find and play 
files on My Computer or 
the multi card slot.
All Images

 Image File
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3. The selected image is zoomed in on.

To view an image in Full Sreen or through a SlideShow.

Click on the SlideShow or Full Screen button below the zoomed in image.

To return to the previous status in SlideShow or Full Screen, press the <Esc>
key or double-click on the screen.

In AVStation now, press the <Esc> key or double-click and click Back.

MOVIE Station
The procedures to play a video (movie) file or DVD/VCD title are described below.

Playing a Movie File

The procedures to play a video file registered to the MOVIE Library are described 
below. (Refer to p53.)

1. Launch AVStation now and click the Movie.

2. Click on All Movies and double-click a movie file in the right pane.
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The movie file is played.

Showing the Play Control window

Press the space bar or move the mouse pointer. The Play Control window 
appears at the bottom.

Playing a DVD

1. Launch AVStation now and insert a DVD title into the DVD drive.

2. In the AVStation now start screen, click on Movie.

3. Click on DVD/VCD and double-click on the DVD title. The DVD title is played.

My Computer
This only appears in 
AVStation now. You can 
manually find and play 
files on My Computer or 
the multi card slot.
All movies
movie File
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Connecting to the Internet

Connecting with a Modem

Use a standard non-digital phone line to connect.

Contact an internet service provider (ISP) for instructions on how to 
connect to and disconnect from the Internet.

1. Connect a telephone line to the computer’s modem port. 

2. Connect to the Internet according to the instructions provided by your ISP.

If the Internet connection is not disconnected properly, additional telephone 
charges may be imposed.
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Connecting Through a Wired LAN

1. Connect a LAN cable to the computer’s LAN port.

2. Click Start > Control Panel.

3. Click Network and Internet Connections in the [Control Panel] window.

4. Click Network Connections in the [Network and Internet Connections] window.

5. Right-click the Local Area Connection icon and click Properties.
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6. On the General tab, select “Internet Protocol(TCP/IP)” and click Properties.

7. To use DHCP:
On the General tab, select “Obtain an IP address automatically” and “Obtain DNS 
server address automatically”. Click OK.

To use a static IP:
On the General tab, select “Use the following IP address” and fill in the IP 
address, Subnet mask, Default gateway, Preferred DNS server, and Alternative 
DNS server fields. Click OK.

To use both DHCP and static IP simultaneously:
On the Alternate Configuration tab, click User configured and fill in the fields.
Click OK.   
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Connecting Through a Wireless LAN (Optional)

A wireless network (Wireless LAN) environment is a network environment that 
enables communication between multiple computers at home or a small-size office 
through wireless LAN devices.

Using the wireless network connections between the systems, you can use normal 
network functions such as sharing of files, folders and printers. When a computer-to 
computer network has been established, a computer that is not connected to the Internet 
can share the Internet by accessing another computer connected to the Internet.  For 
details, see “Sharing Internet Access” on page 77.

The description in this section refers to the Intel(R) PRO/Wireless 3945ABG 
Network Connection (hereafter referred to as an 802.11ABG card) device.

A wireless LAN card is optional. The model of the wireless LAN card is 
determined by the relevant product.

To view the installed wireless LAN card, click Start > Control Panel > 
Performance and Maintenance > System > Hardware tab > Device Manager.

The wireless LAN connection settings will be described on the basis of the 
Windows XP Service Pack 2 installed computer.

It is recommended using the default settings provided by Windows XP for the 
wireless LAN settings for Windows XP installed computers. 
To setup using the software supplied by the wireless LAN card manufacturer, 
refer to "Wireless Network Setup Using the Wireless LAN Setup Program" 
(p71).

To use a wireless network, you have to turn the wireless LAN function on by 
using the Wireless LAN latch. p4

Wireless network connections can be classified into two categories.

1)  Access Point (AP)  

You can connect to an AP to use the network. This is possible only in an environment 
equipped with an AP. For details, see “Connecting to an Access Point (AP)” on page 
66.

What is an Access Point (AP)?
An AP is a network device that bridges wired and wireless LANs, and 
corresponds to a wireless hub in a wired network. You can connect multiple 
wireless LAN installed computers to an AP.
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2) Computer-to-computer (ad hoc)

This is also called a peer-to-peer network. 

In computer-to-computer wireless networks, you can wirelessly connect 2 or more 
computers that have wireless LAN modules. For details, see “Connecting to computer-
to-computer networks (peer-to-peer or ad hoc)” on page 68.

Connecting to an Access Point (AP)
This section describes how to connect to an AP. You can use the network when you are 
connected to an AP. 

For more detailed information such as the network key (encryption key), ask 
your network administrator.

1. Right-click on the Wireless Network Connection ( ) icon on the taskbar, and 
select View Available Wireless Networks.

2. Select an AP (E.g. Test) to connect to and click Connect.

If there is a configured network key for the AP to connect to, the Enter Network 
Key window appears.

Enter the Network Key in the window and then click the Connect button.
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When a network key is not defined for a selected AP, click on Link to display 
the warning message box. Then click Connect again in the box. 

Now when Connected in AP is displayed, and you can access the network.

Checking the connection status

Move the mouse pointer over the Wireless Network Connection ( ) icon on 
the taskbar, and the connection status is displayed.
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Connecting to computer-to-computer networks
(peer-to-peer or ad hoc)

In computer-to-computer wireless networks, you can wirelessly connect 2 or more 
computers that have wireless LAN modules. Using this method, a computer that is not 
connected to the Internet can share the Internet by accessing another computer 
connected to the Internet. (Refer to  "Sharing Internet Access" on page 77.)

You can connect by completing the following steps:

Step 1. Set up a computer-to-computer network on a computer.

Step 2. Connect to the configured computer from other computers.

Step 1. Setting up a computer-to-computer network

1. Right-click on the Wireless Network Connection ( ) icon on the taskbar, and 
select View Available Wireless Networks.

2. Click Change the order of Preferred Networks.

3. On the Wireless Network tab, click Advanced.

4. Clear 'Automatically connect to non-default network' check box, if it is selected. 
Select 'Computer-to-computer (ad hoc) networks only', and click Close.

5. In the Wireless Networks tab, click Add.
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6. Enter the network name (e.g. samsung), and unselect 'The key is provided for me 
automatically'. Enter the encryption key in the Network key field, and click OK.

To prevent a network connection from an unauthorized user, it would be better 
to configure a network key (encryption key). A network key consists of 5 ~ 13 
alphanumeric characters (e.g. magic), or of 10 ~ 26 hexadecimal numbers (a 
hexadecimal number is represented by numbers '0' to '9' or letters 'a' to 'f').

7. Check that the configured network name (e.g. samsung) is in the ’Preferred 
networks’ item, and click OK.

Now your wireless network setup has been completed.
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Step 2. Connecting to the configured computer

1. Right-click on the Wireless Network Connection ( ) icon on the taskbar, and 
select View Available Wireless Networks.

2. Select the wireless network name (e.g. samsung) specified in "Connecting to 
computer-to-computer networks (peer-to-peer or ad hoc)" on page 68, and click 
Connect.

3. Enter a cryptographic key in the network key box and click Connect.

If the network key is not configured in "Connecting to computer-to-computer 
networks (peer-to-peer or ad hoc)" on page 68, just click Connect, without any 
keystrokes.

When connected to the wireless network, the system displays Connected in the 
selected network of the Network Connection window.
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Checking the connection status
Move the mouse pointer over the Wireless Network Connection ( ) icon on 
the taskbar, and the connection status is displayed.

Wireless Network Setup Using the Wireless LAN Setup 
Program

The procedures to connect to an access point using a wireless LAN configuration 
program are described. Since the wireless LAN configuration program is included in 
the system software media, the user has to install the program. 

1. Insert the system software media into the CD drive and install the wireless LAN 
configuration program (PROSet).

Select System Software Media > User Installation > Wireless LAN Driver 
ReadMe, click ReadMe and install according to the instructions.

2. Double-click on the wireless LAN program ( ) icon on the taskbar.

Alternatively, click Start > All Programs > Intel PROSet Wireless > Intel 
PROSet Wireless.

3. In Available Networks, click on Refresh.

4. Select the name of an access point to connect to from the available network list and 
click on Connect.

If a network does not appear, click on Refresh.

5. Enter a WEP key and click the OK button.

The Wireless Security Settings window may differ depending on the security 
settings of the AP.

Click the Advanced button to set up network authentication, data encryption, 
etc. For more security setting information, ask your wireless network 
administrator.


